Chapter 439

Tests for the Difference Between Two Poisson Rates in a Cluster-Randomized Design

Introduction

Cluster-randomized designs are those in which whole clusters of subjects (classes, hospitals, communities, etc.) are sampled, rather than individual subjects. The difference between the event rates of two groups, each consisting of $K_i$ clusters of $M_{ij}$ individuals each, is tested using a two-sample t-test.

The formulas used here are based on Hayes and Bennett (1999) as quoted by Campbell and Walters (2014). These results are also available in Hayes and Moulton (2009).

Technical Details

Our formulation comes from Hayes and Bennett (1999). Let $K1$ and $K2$ represent the number of clusters in groups 1 (control) and 2 (treatment), respectively. Assume that $K1 = K2 = Ki$. Let $M$ represent the number of person-years of observation in each cluster. Let $\lambda_{ij}$ represent the true event rate in the $j$th cluster of the $i$th group and $r_{ij}$ represent the corresponding observed rate. Let $\bar{r}_i$ represent the means of the two cluster rates. Assume that $E(r_{ij}) = \lambda_i$ and $V(r_{ij}) = \sigma_B^2$. Let the coefficient of variation in the $i$th group be $CV_i = \sigma_Bi/\lambda_i$. Let $s_i^2$ be the sample variances computed from the $r_{ij}$.

The inequality of the $\lambda_1$ and $\lambda_2$ can be tested by the following two-sample t-test

$$t_{K1+K2-2} = \frac{\bar{r}_2 - \bar{r}_1}{\sqrt{\frac{s_1^2}{K_1} + \frac{s_2^2}{K_2}}}$$

The formula for the power, given by Hayes and Moulton (2009) for a two-sided significance test of level $\alpha$ to detect an event rate difference is given by

$$Power = \Phi \left[ \sqrt{\frac{(K_1 - 1)(\lambda_2 - \lambda_1)^2}{(\lambda_1 + \lambda_2)^2 + (CV_1\lambda_1)^2 + (CV_2\lambda_2)^2} - z_{1-\alpha/2}} \right]$$

where $z_x = \Phi(x)$ is the standard normal distribution function.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power, Ki, M, and λ2.

Under most situations, you will select either Power to calculate power or Ki to calculate the number of clusters. Occasionally, you may want to fix the number of clusters and find the necessary cluster size.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found.

Note that when searching for M, some scenarios with small Ki’s are not feasible.

Test

Alternative Hypothesis

Specify whether the statistical test is two-sided or one-sided.

- Two-Sided
  This option tests whether the two event rates are different (H1: λ1 ≠ λ2). This is the option that is usually selected.

- One-Sided
  When this option is used and the value of λ1 is less than λ2, rejecting the null hypothesis results in the conclusion that the group 1 (control) event rate (λ1) is LESS THAN the group 2 (treatment) event rate (λ2).
  Otherwise, rejecting the null hypothesis results in the conclusion that the group 1 (control) event rate (λ1) is GREATER THAN the group 2 (treatment) event rate (λ2).

Appropriate Alpha

When you use a one-sided test, you should usually divide your alpha level by two to keep your results standard. For example, you should use 0.025 rather than 0.05.
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90 (beta = 0.10) is commonly used. A single value may be entered or a range of values, such as 0.8 to 0.95 by 0.05, may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for two-sided tests and 0.025 is used for one-sided tests.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Number of Clusters & Cluster Size

K_i (Number of Clusters per Group)
Enter a value (or range of values) for the number of clusters in each group.

You may enter a range of values such as 10 to 20 by 2.

M (Person-Years per Cluster)
This is the average number of person-year per cluster in both groups. This value must be a positive number that is at least one. You can use a list of values such as 100 150 200.

Effect Size

λ_1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per unit time in group 1 (control group). The value must be greater than zero. This value is compared to λ_2 by the statistical test. The difference in the rates, λ_2 - λ_1, is the amount that this design can detect.

Enter a value (or range of values) for the mean event rate per time unit in the control group (group 1).

Example of Estimating λ_1
If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would be

\[ \lambda_1 = \frac{40}{200 \times 1} = 0.2 \text{ per patient-year} \]

If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would be

\[ \lambda_1 = \frac{40}{200 \times 2} = 0.1 \text{ per patient-year} \]
Event Rate Difference

$\lambda_1$ is used with $\lambda_2$ to calculate the event rate difference as

$$Diff = \lambda_2 - \lambda_1$$

such that

$$\lambda_1 = \lambda_2 - Diff$$

The range of acceptable values is $\lambda_1 > 0$. You can enter a single value such as 1 or a series of values such as 1 to 2 by 0.5.

Enter $\lambda_2$, Diff, or Ratio for Group 2

This option lets you indicate how you want to enter $\lambda_2$. The options are

- **$\lambda_2$ (Event Rate of Group 2)**
  Enter the value of $\lambda_2$ directly.

- **Diff (Difference Between Event Rates)**
  Enter values for the difference between the event rates ($Diff = \lambda_2 - \lambda_1$). The value of $\lambda_2$ is equal to $\lambda_1 + Diff$.

- **RR (Ratio of Event Rates)**
  Enter values for the ratio of the event rates ($RR = \lambda_2/\lambda_1$). The value of $\lambda_2$ is equal to $\lambda_1 \times Ratio$. Note that the hypothesis still concerns the difference. This is just a convenient way of specifying a value.

$\lambda_2$ (Event Rate of Group 2)

*This option is displayed only if Enter $\lambda_2$, Diff, or Ratio for Group 2 = “$\lambda_2$ (Event Rate of Group 2)”.*

Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment group). The value must be greater than zero and different from $\lambda_1$. This value is compared to $\lambda_1$ by the statistical test. The difference in the rates, $\lambda_2 - \lambda_1$, is the amount that this design can detect.

Example of Estimating $\lambda_2$

If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would be

$$\lambda_2 = \frac{40}{200 \times 1} = 0.2 \text{ per patient-year}$$

If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would be

$$\lambda_2 = \frac{40}{200 \times 2} = 0.1 \text{ per patient-year}$$

Event Rate Difference

$\lambda_2$ is used with $\lambda_1$ to calculate the event rate difference as

$$Diff = \lambda_2 - \lambda_1$$

such that

$$\lambda_2 = \lambda_1 + Diff$$

The range of acceptable values is $\lambda_2 > 0$. You can enter a single value such as 1 or a series of values such as 1 to 2 by 0.5.
CV1 (COV of Rates in Group 1)

Enter values for CV1. Each cluster in group 1 has an event rate. This is the coefficient of variation of those cluster event rates. The coefficient of variation is equal to the standard deviation of the cluster event rates in group 1 divided by the average event rate, $\lambda_1$.

If prior information is not available, Hayes and Bennett (1999) suggest that CV1 is usually less than 0.25 and seldom greater than 0.50.

CV2 (COV of Rates in Group 2)

Enter values for CV2. Each cluster in the treatment group has an event rate. This is the coefficient of variation of those cluster event rates. The coefficient of variation is equal to the standard deviation of the cluster event rates in group 2 divided by the average event rate, $\lambda_2$.

If prior information is not available, Hayes and Bennett (1999) suggest that CV2 is usually less than 0.25 and seldom greater than 0.50.

Use CV1

If you enter “CV1”, the value of CV2 will be set to that of CV1.
Example 1 – Calculating Power

Suppose that a cluster randomized study is to be conducted in which $\lambda_1 = 0.50$; $\lambda_2 = 0.6$; CV1 = CV2 = 0.25; M = 20, 40, 60, or 80; Ki = 20, 40, 60, 80, or 100; and alpha = 0.05. The power is to be calculated for a two-sided test.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Ki (Number of Clusters per Group)</td>
<td>20 40 60 80 100</td>
</tr>
<tr>
<td>M (Person-Years per Cluster)</td>
<td>20 40 60 80</td>
</tr>
<tr>
<td>$\lambda_1$ (Event Rate of Group 1)</td>
<td>0.50</td>
</tr>
<tr>
<td>$\lambda_2$ (Event Rate of Group 2)</td>
<td>0.60</td>
</tr>
<tr>
<td>CV1 (COV of Rates in Group 1)</td>
<td>0.25</td>
</tr>
<tr>
<td>CV2 (COV of Rates in Group 2)</td>
<td>CV1</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>K</th>
<th>Ni</th>
<th>Ki</th>
<th>M</th>
<th>$\lambda_1$</th>
<th>$\lambda_2$</th>
<th>$\lambda_2/\lambda_1$</th>
<th>Event Rate Ratio</th>
<th>COV Gr 1</th>
<th>COV Gr 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2975</td>
<td>800</td>
<td>40</td>
<td>40</td>
<td>20</td>
<td>20</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.3980</td>
<td>1600</td>
<td>40</td>
<td>80</td>
<td>20</td>
<td>40</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.4501</td>
<td>2400</td>
<td>40</td>
<td>120</td>
<td>20</td>
<td>60</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.4816</td>
<td>3200</td>
<td>40</td>
<td>160</td>
<td>20</td>
<td>80</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.5345</td>
<td>1600</td>
<td>80</td>
<td>80</td>
<td>40</td>
<td>20</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.6836</td>
<td>3200</td>
<td>80</td>
<td>160</td>
<td>40</td>
<td>40</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.7480</td>
<td>4800</td>
<td>80</td>
<td>2400</td>
<td>40</td>
<td>60</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.7829</td>
<td>6400</td>
<td>80</td>
<td>3200</td>
<td>40</td>
<td>80</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.7113</td>
<td>2400</td>
<td>120</td>
<td>1200</td>
<td>60</td>
<td>20</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.8505</td>
<td>4800</td>
<td>120</td>
<td>2400</td>
<td>60</td>
<td>40</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.8984</td>
<td>7200</td>
<td>120</td>
<td>3600</td>
<td>60</td>
<td>60</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.9211</td>
<td>9600</td>
<td>120</td>
<td>4800</td>
<td>60</td>
<td>80</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.8296</td>
<td>3200</td>
<td>160</td>
<td>1600</td>
<td>80</td>
<td>20</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.9344</td>
<td>6400</td>
<td>160</td>
<td>3200</td>
<td>80</td>
<td>40</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
<tr>
<td>0.9625</td>
<td>9600</td>
<td>160</td>
<td>4800</td>
<td>80</td>
<td>60</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.20</td>
<td>0.25</td>
<td>0.25</td>
<td>0.05</td>
</tr>
</tbody>
</table>

(Report Continues)
Tests for the Difference Between Two Poisson Rates in a Cluster-Randomized Design

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of person-years in the design. N = N1 + N2.
K is the total number of clusters in the design. K = K1 + K2.
Ni represents N1 and N2, the number of person-years in each group. This formulation assumes N1 = N2.
Ki represents K1 and K2, the number of clusters in each group. This formulation assumes K1 = K2.
M is the average number of person-years per cluster in all clusters.
λ1 is the event (or incidence) rate of the control group. This is the baseline rate.
λ2 is the event (or incidence) rate of the treatment group.
λ2 - λ1 is the difference between the treatment event rate and the control event rate.
λ2 / λ1 is the ratio of the treatment event rate and the control event rate.
CV1 is the coefficient of variation of the cluster event rates in the control group.
CV2 is the coefficient of variation of the cluster event rates in the treatment group.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the event rates are actually equal.

Summary Statements
A total sample size of 800 person-years, which are obtained by sampling 40 clusters (20 in each group or arm) with an average of 20 person-years per cluster, achieve 30% power to detect a difference of 0.1000 between the treatment event rate 0.6000 and the control event rate 0.5000. The between-cluster coefficient of variation in the control group was 0.250 and in the treatment group was 0.250. A two-sided t-test of the event-rate difference was used with a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus the cluster size for the two alpha values.
Example 2 – Validation using Hayes and Moulton (2009)

Hayes and Moulton (2009) on page 109 present a power calculation for this test. For the values $\lambda_1 = 0.0148$; $\lambda_2 = 0.0104$; $CV_1 = CV_2 = 0.29$; $M = 424$; $\alpha = 0.05$; and $K_1 = K_2 = 28$. The resulting power value is 0.69.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

### Option Value
**Design Tab**
- Solve For: Power
- Alternative Hypothesis: Two-Sided
- $\alpha = 0.05$
- $K_1$ (Number of Clusters per Group): 28
- $M$ (Person-Years per Cluster): 424
- $\lambda_1$ (Event Rate of Group 1): 0.0148
- Enter $\lambda_2$, Diff, or Ratio for Group 2: $\lambda_2$ (Event Rate of Group 2)
- $\lambda_2$ (Event Rate of Group 2): 0.0104
- $CV_1$ (COV of Rates in Group 1): 0.29
- $CV_2$ (COV of Rates in Group 2): $CV_1$

**Output**

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>K</th>
<th>Ni</th>
<th>Ki</th>
<th>M</th>
<th>$\lambda_1$</th>
<th>$\lambda_2$</th>
<th>$\lambda_2 - \lambda_1$</th>
<th>$\lambda_2 / \lambda_1$</th>
<th>COV</th>
<th>COV</th>
<th>$\alpha$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.6886</td>
<td>23744</td>
<td>56</td>
<td>11872</td>
<td>28</td>
<td>424</td>
<td>0.0148</td>
<td>0.0104</td>
<td>-0.0044</td>
<td>0.70</td>
<td>0.290</td>
<td>0.290</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS calculates the same power.